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General information 
READ THIS USER MANUAL CAREFULLY BEFORE USING ANY EPOC HARDWARE 
 
Applicable Regulations 
 
Unmanned Aircraft are subject to regulations enforced by civil aviation authorities. Regulations 
may vary depending on the country where you intend to operate your product. ANY USE OF 
EPOC UNMANNED INC. PRODUCTS IN BREACH OF THE LAW OF THE COUNTRY WHERE 
YOU OPERATE THE PRODUCT IS UNDER YOUR SOLE RESPONSIBILITY. INFORM 
YOURSELF BEFORE USING THE PRODUCT. CANADA HAS LAWS THAT LIMIT THE USE 
OF UNMANNED AIRCRAFT TO LINE-OF-SIGHT OPERATIONS AND/OR PROHIBIT THE 
USE OF UNMANNED AIRCRAFT AT ALL OR IN SPECIFIC AREAS/AIRSPACE. 
 
Limitation of Liability 
 
EPOC UNMANNED INC. SHALL NOT BE LIABLE FOR SPECIAL, INDIRECT, INCIDENTAL 
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR PRODUCTION OR 
COMMERCIAL LOSS IN ANY WAY, REGARDLESS OF WHETHER SUCH CLAIM IS BASED 
IN CONTRACT, WARRANTY, TORT, NEGLIGENCE, STRICT LIABILITY OR ANY OTHER 
THEORY OF LIABILITY, EVEN IF EPOC UNMANNED INC. HAS BEEN ADVISED OF SUCH 
DAMAGES. Further, in no event shall the liability of EPOC UNMANNED INC. exceed the 
individual price of the Product on which liability is asserted. As EPOC UNMANNED INC. has no 
control over use, setup, nal assembly, modication or misuse, no liability shall be assumed nor 
accepted for any resulting damage or injury. By the act of use, setup or assembly, the user 
accepts all resulting liability. If you as the purchaser or the User are not prepared to accept the 
liability associated with the use of the product, purchaser is advised to return the product 
immediately in new and unused condition to the place of purchase. 
 
Limited Warranty and Service Agreement 
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Epoc MK III has a limited warranty for the first 50 hours of service. After this period the drone is 
to be returned for regular service every 50 hours. After the first 50 hours all component and 
labour cost of repair or maintenance is at the expense of the purchaser.  
 
EPOC UNMANNED INC. reserves the right to make changes to specifications and product 
descriptions contained in this document at any time without notice. Please visit EPOCUAV.COM 
or contact info@epocdronesurvey.com for the latest revision. Copyright © 2020 EPOC 
UNMANNED INC. 
 

 
Technical Support 
 
If you have questions regarding Epoc hardware or software please use the troubleshooting 
section of this document and then contact info@epocdronesurvey.com if a resolution is not 
found.  
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Using this manual 

Product Profile 

Introduction / general 
Stryder drones are professionally designed and built to perform in a demanding and ever 
changing industrial market.  
 
For flight controls see “Manual control of drone with transmitter” in this manual. 
The Stryder MK III airframe is a quad rotor (4 rotor drone). The Stryder drone is not permitted to 
fly any other payloads than the supplied and approved payloads. 
 
Maximum speed ascending and descending rates are pre-programmed and limited by software 
on the Stryder drone. Modification of these and any other parameters is strictly prohibited.  
 
Inside all Stryder drones is an industrial flight controller as well as a communication system. All 
broadcasting components fall under CSA standards for broadcasting.  
 
Stryder is powered by intelligent flight batteries, these batteries give warning for overheating, 
over cooling, over charging and battery levels. The smart batteries also self-discharge when left 
too long. 
 
The Stryder MK III airframe is a folding design with fixed landing gear. Ensure care is taken 
when folding the arms that no wires are pinched. The cables are protected with mesh such that 
they should easily move within the arm when folded.  
 
There is an hour meter installed on all Stryder drones. The customer must return the drone for 
regular maintenance performed by a certified technician at a regular 50 hour intervals. 
 
Do not exceed maximum payload capacity. Only use the supplied payloads with recommended 
batteries.  
 
Do not go near, or touch, the propellers or motors while they are spinning as this will cause 
serious injuries.  
 
Disconnect the battery during transport and at any time when the drone is not in use for safety. 
 
Do not transport the drone with a battery mounted in the tray this includes inside a 
vehicle or on foot.  
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The drone should be moved by hand without the battery installed by standing at the rear of the 
drone and grasping the rear left boom and front right boom on the MK III or grasping the front 
and rear of the MK I drone. 
 
Only use Epoc Unmanned Inc. manufactured or recommended parts.  
 
If you have any questions or concerns do not hesitate to contact your reseller or Epoc 
Unmanned inc. directly.   
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Warnings 
Never fly over people. Drones are complex mechanical pieces of equipment that can fail. Never 
fly or plan a flight directly over people. Never stand directly under a drone while it is flying in any 
state including take-off, landing or horizontal flight.  
 
Rotating propellers can cause serious injury and damage. Fly with caution at all times. Respect 
specified setbacks during take off and landings of 30 feet at all times.  
 
Safety gloves and CSA approved safety glasses to be worn at all times. 
 

Package contents 
The Stryder MK I and MK III drones are supplied with the following as standard 

● Drone c/w custom case and foam insert 
● CGS case c/w laptop, transmitter, mast, tool set 

 
The Stryder drones come completely assembled and tested. There is no need for any 
assembly. Adjusting or tightening propellers / bolts / nuts may cause malfunction in flight. If paint 
mark indicates that movement or loosening has occurred contact the reseller immediately. 
 
Inspect the drone for damages during shipping by doing the following: 
 

● Grab each motor assembly and twist from left to right. It should not move. 
● Inspect the propellers for cracks, chips, warpage or signs of wear. 
● Inspect the propeller hubs (hinge point near the center of the motor) to see if the bolt has 

turned. There are paint marks to indicate any movement.  
● Inspect the drone for evidence of damage during transport.  
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Aircraft diagrams 
 
Stryder MK I 
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Stryder MK III 
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Remote controller diagram 

 

Modes 
The Stryder drone transmitter has three modes for flight by default. The modes are controlled by 
SF and SC switches as shown above. 
 
GPS = Position hold mode. In this mode the drone will hold its current GPS position and 
elevation when the user gives no input to the transmitter sticks. This mode is used to fly 
manually. This is done with the SF switch pushed away from the pilot. Confirmation of this can 
be seen on the GCS heads up display. 
 
Auto = Autonomous mode. In this mode the drone will perform automated tasks given to it by 
apps from the smart device. This is controlled by the SF switch in the position toward the pilot. 
This mode should only be selected after a hover test showing that the drone is holding 
position correctly and the drone is above 30m. 
 
RTL = Return to Launch. When toggled in the “down position” the drone will return to it’s launch 
position and land. This is done with the SC switch. Manual corrections can be made with the 
transmitter to adjust where the drone will land.  
 
Timer = The timer automatically starts when the drone is put into Auto mode. This can be reset 
by the SH switch. 
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Charging the transmitter 
 
The transmitter is charged via the USB plug in the back of the transmitter or the barrel jack plug 
on the bottom depending on model. When the light under the power button on the front of the 
transmitter turns off then the transmitter is charged.  

Control sticks 
Manual control over the drone is carried out with the following inputs to the transmitter. Note that 
even in the “Auto” mode inputs to the control sticks will have an effect on the flight of the drone. 
Therefore the transmitter should be placed on the hanger while in auto mode such that the 
sticks will not be bumped.  
 
It is highly recommended that the transmitter be calibrated on a regular basis in order to correct 
for temperature drift in the electronic components. See transmitter calibration section in this 
document. 
 
See the following diagrams to explain what happens to the aircraft when the corresponding stick 
input is given when in any mode. 

Moving the left stick up / down will increase or decrease elevation of Stryder. 
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Moving the left stick to the left / right will rotate the Stryder about its center axis. 

 

Moving the right stick up / down will move the Stryder forward or backward in the direction the 
drone is facing. 

 

Moving the right stick left / right will move the Stryder to the left or right of its direction of travel. 
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In order to arm and disarm the drone only the left stick is used.  

To arm the drone hold the left stick down and to the right.. 

To disarm the drone hold the left stick down and to the left until the motors and propellers 
stop turning completely.  

Calibrating the transmitter 

If the drone is “drifting” in Position hold mode then the transmitter may need to be calibrated. 
First review the troubleshooting section at the end of this manual to see if transmitter calibration 
is needed.  
 
NOTE: Calibration of the transmitter is an advanced operation and done at the user's own 
risk. If you do not accept this risk then return the drone to Epoc for calibration.  
 
If transmitter calibration is required follow the following procedure.  
 
There are two calibrations possible and they must be done in this order 
 

1) Horus X10 calibration (you must do with the drone disconnected)  
2) Pixhawk (flight control) transmitter calibration 

 
Horus x10 calibration is as follows.  
SAFETY WARNING do not power the drone. This procedure is strictly to calibrate the 
transmitter within itself. 

1. Turn on the transmitter 
2. Ensure all trims are centered on the transmitter. Do this by bumping them one way or 

another then bumping them back. When centered the radio should speak "trim centre” 
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3. Press and hold the SYS button to get the system menu up 

4. Press the Page up/Dn button five times until you see the calibration option 

5. Now press the grey button on the right (OK button) 
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6. Press grey button again to start calibration 

7. Leave sticks centred 
8. Press enter to continue the calibration 
9. Move all sticks, sliders, switches to their extreme positions 
10. Push OK and you are done. 
11. THE TRANSMITTER MUST BE REBOOTED 

 
  
Pixhawk transmitter calibration is as follows AFTER the transmitter has been calibrated 
as per above.  
 
The following are instructions on how to re-calibrate the transmitter on an EPOC drone using a 
Horus X10 transmitter 
 
SAFETY WARNING this procedure must be done outside in a clear area because the pilot 
may inadvertently arm the drone. This is very unlikely however it is safest to be in a clear space 
with the arms unfolded and locked. If the drone arms during this procedure simply move 
the stick to the disarm position.  
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1. Plug in the drone battery and turn on the transmitter 
2. Ensure all trims are centered on the transmitter. Do this by bumping them one way or 

another then bumping them back. When centered the radio should speak "trim centre” 

 
 

 
3. Power on the laptop and start up Mission Planner 
4. Connect to the drone via mavlink as per usual 
5. Click on the "Initial Setup" tab across the top 
6. Click on “Manditory Hardware” 
7. Click on "Radio Calibration" along the left 
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8. Click on "Calibrate Radio" and say OK (you are outside if the motors arm just disarm 
them) 

9. It will then ask you to click OK and move all sticks and switches to their extremes. Go 
ahead and click OK.  

10. Now move the sticks around in a "Circle" but really you are just hitting the four corners of 
the stick limits.  

11. BE CAREFUL do not hold the left stick in the arming too long or it will arm the 
drone. If this happens just give the disarm command and it will shut off.  

12. Next move all switches to their full extent.  
13. Ensure not to forget the switches on the top of the transmitter. 
14. Then click on "Click when done" 
15. Centre your sticks and click OK as instructed. 
16. WAIT 20 seconds a screen will pop up. Take a photo of this screen and text it to 403 

973 0448 
17. Numbers should look similar to the ones below. Note that all used channels are from the 

high 900's to the low 2000's some vary slightly and that is OK 

 
 

18. After verifying the numbers click OK 
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19. Go back to the "Flight data" tab on the top 
20. Note what mode the drone is in. Cycle through PosHold and Auto modes on the 

transmitter. Monitor that each mode shows up correctly.  
21. Now flip the RTL switch. No matter what mode you are in RTL will override it and should 

say RTL on the screen.  

 
 

22. When all modes are verified, unplug the drone, turn off the transmitter. 
23. Plug in the drone, turn on the transmitter, connect to the PC with the data modem. 
24. Verify that all modes are working correctly as per #23 above 
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Base station (optional) 

Setup 

Operation 

Manual log download 

Maintenance 
All stryder drones have a built in hour meter and must be returned to a qualified service provider 
for maintenance every 50 hours. It is the responsibility of the owner to ensure this is completed.  

Flight 

Pre-flight 

Checklist 
The following is an example checklist. 
The most up to date checklist version can be found on the Epoc website under downloads.  
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Stryder MK III Operations Checklist RTL Voltage 44.00 V 

Flight Date Pilot Visual Observer 
 

Client Site Airspace Class 
 

VRF/Aircraft Freq. Aerodrome/Tower Ph. 
 

Nav Canada Emerg Ph. 

Loadout 

Item Charged Packed  Item Packed 

RC 
transmitter 

  SD card  

Base Station   USB thumb 
drive 
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Camera 
batteries 

  USB cable  

Laptop   UAV boom 
pliers 

 

Aircraft Radio   UAV  

Anemometer   Cellular 
phone 

 

UAV 
batteries 

  Phone 
charger 

 

Preflight Start time 
 

Place base station and power on (minimum run time 30 min or 1 hr per km 
baseline) 

 

Survey base station location (dimple top center of lid)  

Survey minimum 4 check shots (min 24" flat area around check shot)  

Place landing mat on level ground  

Secure 30m/100' area around landing mat  

Place UAV on landing mat and remove foam rotor stays  

Unfold UAV booms and hand tighten boom hinges  

Tighten boom hinges using boom pliers  

Unfold rotors, confirm rotors bolts tight and rotors not damaged  

Confirm folding prop adapter paint mark on bolt head unchanged  

Confirm motors rotate smoothly and silently  

Install USB thumb drive in UAV payload pod  

Install SD card in camera  

Install battery in camera and power camera on  

Format SD card  
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Check camera focus (turn focus ring to infinity then move white square one 
tick back) 

 

Confirm payload switch position is correct  

Install UAV battery. Do not move or disturb UAV until beeping stops  

Confirm payload LED is off, start payload (push yellow button)  

Turn on camera, close payload lid, confirm both latches are locked  

Raise mast and lock transmitter hanger at eye-height  

Power on transmitter  

Power on laptop and open Mission Planner software  

Confirm laptop connected to transmitter wifi hotspot  

Connect to UAV  

Confirm battery voltage/full battery (approx. 50.1 V)  

Load mission plan or create new mission plan (flight plan tab) 120m alt, 10m/s  

Confirm mission plan altitudes are set to "Relative" (not absolute or terrain)  

Write mission plan to UAV  

Confirm mission plan correct on heads up display (flight data tab)  

Power on Aircraft radio and confirm frequency and wait 30 seconds  

Confirm transmitter switch function (RTL, Auto)  

Confirm payload status light is solid green  

Confirm payload latches secure  

Confirm both battery cables are plugged in  

Confirm all boom hinges are tight  



 

 

Mission planning 
 
Stryder drones are supplied with a waterproof laptop that has a known, tested and stable 
version of Mission Planner installed. It is strictly prohibited to update Mission Planner. If 
Mission Planner is updated contact Epoc for instructions as to how to install the correct version. 
 
NOTE: It is also strictly prohibited that the user fly the drone with any other laptop than 
the one supplied with the drone. Doing so will void any warranty and may put the pilot and 
crew in danger. 
 
In order to plan a mission you first must connect the Transmitter (otherwise known as TX) to the 
Laptop over wifi with the drone connected. This tells Mission Planner where you are currently 
and allows map caching for when you are in the field. Follow these steps to connect your 
transmitter to the laptop and drone as well as cache a map of a new area. 
 

1) Power on the laptop 
2) Power on the TX 
3) Click on the wifi icon in the bottom right corner of the windows screen. This will bring up 

a list of available wifi networks and hotspots. 
4) Connect to the one that starts with TXMOD. If asked the password is txmod123 
5) This means the TX is connected to the laptop.  
6) Next connect to the drone by changing the drop downs in the top right corner of Mission 

Planner to TCP and 115200 then click connect 
7) The host name/ip is 192.168.4.1  
8) The remote port is 23 
9) You should see data on the screen updating now 
10) Now the TX is connected to both the drone and the transmitter. 
11) Ensure you have connection by watching the data on the heads up display  
12) Ensure the “Auto Pan” box is checked just below the centre of the map area. 
13) Wait for the gps to attain 10 satellites shown in the bottom left corner of the map area 

beside where it says “sats”  
14) After enough satellites are seen click the wifi icon in the bottom right corner of the 

Windows 10 screen. This icon will have changed from a wifi symbol to a globe symbol. 
15) Click on the local wifi which you will be obtaining data from. This could be a hotspot wifi 

on your phone or your office / site wifi network. Enter a password if your ISP requires it.  

22 



16) After connecting to your local wifi click back on the map and pan / zoom around the area 
where you will be flying. Ensure to zoom to the level you will want to see when flying. 
This caches the map locally so that you do not need to be on the internet at the field. 

17) Disconnect from your local wifi internet connection 
18) Power down the transmitter and power it on again. 
19) Wait 30 seconds as it can take time to establish a solid connection. 
20) Open the available wifi networks again and click on the TXMOD network. This time 

select “connect automatically” if you wish. You will not be asked for a password 
assuming you were able to connect before.  

21) For hostname /ip type in the following which will only need to be done once 192.168.4.1 
22) Port is 23 click connect.  
23) This time you should see your map filled in with the areas you had planned earlier.  

Flight modes 
The Stryder has three flight modes available: 

1) Pos Hold 
a) This is used for initial take off and emergency procedures 

2) Auto 
a) After initial take off and confirmation that drone is holding position this mode is 

selected for automatic mission flight after a 30m minimum altitude is attained 
in Pos Hold mode. 

3) RTL  
a) This mode is used to return the drone to launch manually if an issue arises during 

flight or if the user wishes to abort the flight for any reason.  

Data links 
RC control and Data are sent over the same 900mhz signal. The GCS data is relayed from the 
transmitter to the laptop over Wifi. 

Failsafes 
There are two failsafes: 

1) Battery low failsafe. 
a) This returns the drone to launch when the battery has been depleted. 

2) Out of range failsafe 
a) This returns the drone to launch if the GCS or transmitter loses connection with 

the drone. With the transmitter placed correctly on the mast at the GCS standard 
range is 800-1000m 
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Warnings 

In-flight 

Normal flight conditions and instrument gauges 

Emergency procedures 
In the event of abnormal behavior such that the drone is not performing as expected. The 
following procedure should be followed: 

 
1. If the planned autopilot course is not being adhered to the first action is to select the RTL 

switch on your Transmitter.  
2. If the drone appears to be returning home then allow it to do so unaided.  
3. If the drone fails to RTL (return to landing) after 5-10 seconds then try selecting RTL on 

the ground control software. 
4. If both the above fail, a manual RTL can be performed so long as you still have a data 

link by changing the mode to Position hold (see next step) 
5. While observing the map rotate the drone with the left stick such that the nose of the 

drone is facing the home point using the left stick. When facing the home point push 
forward on the right stick GENTLY until the drone is coming back home. Flight speed 
should be kept about 10m/s (or less) and monitored on the GCS. Keep flying until the 
drone is close to home or the spotter feels you can take visual control. Lower the throttle 
until the drone lands and shuts off motors.  

6. If none it is not possible to manually orientate and fly the drone home then leaving the 
drone in position hold and lowering the throttle down all the way and holding it there will 
force the drone to land where it is.  

 

Landing procedure 

Battery depleted in flight 

 
The Stryder drone is equipped with onboard battery monitoring. When the battery is depleted to 
a preset voltage the aircraft will automatically return to the launch point. It is highly 
recommended to allow the drone to complete this action. 
 
Important: When the drone’s skids touch the ground the user must still give the disarm 
command (left stick down and to the left) until the rotors stop turning. The drone is 
capable of completing this on it’s on however for safety reasons its best to give the disarm 
command as well in case of a discrepancy between the barometric sensor and reality. 
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Note that cancelling a low battery RTL action should not be done unless there is a safety reason 
to do so such as: 

1) The path of the RTL will cause the drone to strike an object 
2) The RTL path does not appear to be headed in the home direction 

Cancelling the RTL can be done by switching in and out of any mode such as between “auto 
and position hold” or toggling the “RTL” mode switch on and off.  

● If RTL was aborted because of an obstruction in the path back to home then when the 
path is clear simply select the RTL mode switch again.  

● If RTL was aborted because of unexpected flight behavior then check if the craft is 
holding position. If so then initial RTL again and abort if needed again.  

● If RTL was aborted because of unexpected flight behavior and the craft is NOT holding 
position then attempt to fly the drone manually home. If that fails lower the throttle to land 
the drone. 

 

 

 

Post-flight 

Checklist 
After each flight the following should be checked on the drone 

1) Check each motor and see if on or more are warmer than the others. Warm motors are 
normal however they should not be too hot to touch. If they are then stop flight 
immediately and contact Epoc If one motor is quite noticeably warmer than the others on 
a regular basis then the drone should be sent in for service as a bearing may be failing.  

2) Walk around the drone and check all paint marks to ensure they have not moved on the 
propellers and motors. If they have changed contact Epoc immediately.  

 

Payloads 

Direct Geo-referencing payload 

Operation 
When operating the geo payload follow the checklist found in the “Preflight Checklist” section of 
this manual.  
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Camera settings 
When operating the camera follow the checklist found in the “Preflight Checklist” section of this 
manual.  

Post Processing 

Software use 

 

Step 1: Geotag flight photos using GeoTagr 
1. Make a copy of project template folder and rename as required 
2. Copy raw base station data to project folder (((Project_folder > 1_Survey > 

1_Base_RINEX_file)))  
3. Convert raw base station data to RINEX format by dragging and dropping the raw file on 

top of the appropriate conversion utility: sbp2rinex.exe for .spb (Epoc magic triangle 
base station) files, tps2rin.exe (Topcon base station). If using Trimble, Leica etc. for a 
base station contact the manufacturer for a RINEX conversion workflow 

4. Copy raw UAV data to project folder using individual flight folders (((Project_folder > 
1_Survey > 2_Stryder_Geo_LOG_files > Flight_1, 2, 3 etc.))) 

5. Copy flight photos to project folder using individual flight folders (((Project_folder > 
1_Survey > 3_Photos > Flight_1, 2, 3 etc.))) Protip: set the SD card file folder view to 
‘large icons’ to speed up breaking the photos into individual flights (right click > view > 
large icons). You will be able to see the three test photos (typically orange if using a 
flight mat) at the beginning of each flight which makes it easy to find the start and finish 
of each flight 

6. Open GeoTagr software 
7. Click on the three dots to the right of each of the input data file locations and output data 

folder locations and point to the appropriate files/folders: 

 

Protip: set the project name to the date of the survey and append with unique names 
such as F1, F2, F3 etc. for each individual flight 
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8. Input the base station coordinate and antenna height: 

 

Protip: unselect the “Write geotags to image EXIF” check box. This will prevent the 
software from writing geolocation data to each individual image and greatly speed up 
post processing. The image geolocation data is written to a .csv file that can be imported 
in photogrammetry software quickly and easily 
Protip: If the local survey coordinate system uses a geoid/orthometric height, enter the 
orthometric height of the base station into the “Altitude” box instead of the ellipsoidal 
height. This will shift the survey to the geoid and reduce the amount of height adjustment 
required during post processing 
Protip: If using the Epoc magic triangle base station set the antenna height to 0.000m 

9. Click “Process” (bottom right corner) 
10. Repeat Step 7 for each flight. Adjust the “Project Name”, “UAV” and “Photo Folder” 

inputs as required. All other inputs/settings will remain the same for all flights. Protip: if 
the post processing dialogue shows a solution quality of Q=5 during processing the base 
station coordinate is usually incorrect 

11. When post processing is complete open the Google Earth .kmz file for each flight 
(((Project_folder > 1_Survey > 4_GeoTAGR_output > Google_Earth))) 
and check that all photos have a fixed solution for their geotag (green pin). If pins are 
yellow (float) or red (no solution) there is typically a problem with the base station data 
(not enough static data logged prior to flight). Protip: ensure a minimum of 30 min of 
base station data is logged if the base is within 200m of the take off/landing zone of the 
UAV. If the base is set further than 200m from the LZ ensure a minimum of 60 min of 
base station is logged for every 1000m of baseline between base station and UAV. Best 
results are obtained when the base station is located at the LZ 

 

Step 2: Photogrammetric processing (Agisoft Metashape) 

 

1. Open Metashape and save the Metashape instance to the project folder using the 
appropriate file name (((Project_folder > 2_Photoscan))) 

2. Open the reference settings dialogue by clicking the wrench and hammer icon on the 
reference pane 
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3. Set the coordinate system to “WGS 84” and set the “Camera accuracy” to 0.015m: 

 

4. Import the flight photos using the “Workflow” drop down menu: 
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Protip: use the “Add Folder” option and select the flight photo root folder (((Project_folder 
> 1_Survey > 3_Photos))) to add all photos from all flights in one step. Self test photos 
do not need to be removed as they will not align and be ignored. 

5. Open the import dialogue by clicking the folder icon on the reference pane 

 

 
6. Navigate to the geotag .csv file for the first flight (((Project_folder > 1_Survey > 

4_GeoTAGR_output > F1.csv))) and open it  
7. Ensure the coordinate system, delimiter and column order are correct and click OK: 
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8. Repeat steps 5-7 for each flight until all geotags have been imported 
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9. Import the Metashape batch processing script from using the “Workflow” drop down 

menu to open the Batch Process dialogue: 
 

 

 
Then click the folder icon in the bottom right corner and navigate to (((Project_Folder > 
2_Photoscan > Batch_script_WGS84_No_GCP.xml))) 
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10. Ensure the “Save project after each step” box is selected then double click on Step 6 

“Generate Report” 
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11. Double click on the “Path” box to open the output file location then click the small box 

with three dots to open Windows Explorer. Navigate to (((Project_Folder > 
3_Deliverables > 1_Flight_report))), input the appropriate file name and click “Save” 
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12. Double click on Step 7 “Export Points”: 
 

 

 
13. Double click on the “Path” box to open the output file location then click the small box 

with three dots to open Windows Explorer. Navigate to (((Project_Folder > 
3_Deliverables > 2_Point_cloud))), input the appropriate file name, select ASPRS LAS 
(*.las) for the file type and and click “Save” 
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14. Double click on Step 8 “Export Orthomosaic”: 

 

 

36 



 
15. Double click on the “Path” box to open the output file location then click the small box 

with three dots to open Windows Explorer. Navigate to (((Project_Folder > 
3_Deliverables > 3_Ortho_photo))), input the appropriate file name and click “Save” 
 

 

 
16. Click “OK” on the main batch processing dialogue: 
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Step 3: Data reprojection, height adjustment, accuracy validation (Bluemarble 
Globalmapper w/ LIDAR module): 

 

1. Open Globalmapper and click “Open Data Files” on the main work area: 
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2. Navigate to (((Project_Folder > 3_Deliverables > 2_Point_cloud))) and open the project 
.las file 

3. Check that the “Lidar Load Options” match the settings shown below and click “OK”: 
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4. While the .las file is loading, create .ecw orthophoto files from the .tiff files Metashape 

output. Open another instance of Globalmapper by right clicking on the Globalmapper 
icon and selecting “Globalmapper” 
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5. In the new instance of Globalmapper select File > Batch Convert/Reproject from the 

main drop down menu at the top left corner of the screen: 
 

 

 
6. Select “GeoTIFF (Imagery, Raster Maps, and Terrain) as the File Type to Convert From: 

 

 

 
7. Select “ECW” as the File Type to Convert To: 
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8. Click the “Add Files…” button, navigate to (((Project_folder > 3_Deliverables > 

3_Ortho_photo))), select all GeoTIFF files in the folder by holding SHIFT or CTRL while 
selecting individual files and click “Open”. Ensure all options match those shown below 
and click “OK” to start the batch processing: 
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9. Return to the Globalmapper instance containing the point cloud. Reproject the point 

cloud to the local coordinate system by selecting Tools > Configure > Projection: 
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10. Change the projection, zone and datum to match the local coordinate system and then 

click “OK”: 
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11. Open the check shot/ground control point file by pressing CTRL+O or selecting File > 
Open Data File(s): 

 

 
12. Ensure the check shot/ground control point is formatted N,E,Z,D and the import dialogue 

options match those shown below then click “OK” 
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13. Confirm the auto-detected projection, zone and datum are correct then click “OK” 

 
14. Located the triangle shaped LIDAR QC tool button on the upper toolbar and click it: 

 
15. Ensure the auto-detected .csv and .las files are correct and selected then click “OK” 
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16. Locate the average RMSE error in the bottom left corner, write down the value then click 

“Close”: 

 
17. Right click on the point cloud in the Control Center on the left hand side of the screen 

and select “Options”: 
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18. Select the “Alter Elevation Values” tab, enter the average RMSE error value in the 

“Offset” box and click “OK”: 
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19. Repeat steps 14, 15 and 16 
20. Check the new average error. If the error has increased, enter a negative value into the 

“Offset” box (the data needs to go down instead of up). If the error has decreased the 
height adjustment is complete: 
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21. Turn off the check shot/ground control point layer by unselecting the layer checkbox in 
the control center so that the .las file is the only visible data: 

 
22. Export the adjusted and reprojected .las data by selecting File > Export > Export 

Vector/Lidar Format: 
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23. Select “Lidar LAS File” as the Export Format and click “OK”: 

 
24. Ensure the export options match those shown and click “OK”: 
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25. Navigate to (((Project_Folder > 3_Deliverables > 2_Point_cloud))), enter a filename, 

ensure “Lidar LAS Files (*.las)” is selected as the file type and click “Save”: 
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26. When the ECW batch conversion process completes, import the ECW file into the 
Globalmapper instance containing the .las file using CTRL+O. The ECW file will be 
automatically reprojected. Turn off the .las file in by unchecking it in the control center so 
that the ECW file is the only visible data. Export the reprojected ECW file by selecting 
File > Export > Export Raster/Image Format: 

 
27. Select “ECW file” as the Export Format: 
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Battery management 

Battery lights and indications / maintenance 
Stryder MK I drones are supplied with 6S 22ah batteries. Stryder MK III drones are supplied 
with 12S 32ah batteries. These batteries are generally self sustaining but the user needs to 
follow guidelines in order to make them last as long as possible.  
 
Batteries must be stored at room temperature in a dry place. They must NEVER be charged 
unattended. If the battery is to be stored for more than three weeks it should be discharged to 
storage level using the battery charger.  
 
The following is a guideline for battery maintenance.  
 
 

 
 
The batteries should be replaced if ever dropped and should be kept warm in the field anytime 
the ambient temperature is below 10 deg C. This is best done by keeping them in the truck 
sitting in the passenger seat footwell and the heat blowing on them. This will give maximum 
flight time.  
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Time until next flight Recommendation 

Next 48 hours Charge and use as normal 

48 hours to one week Top up charge in balance mode on charger 
the night before flight or the day of flight 

One week to two weeks Top up charge in balance mode on charger 
Possible slight loss in flight time on first  
battery cycle 

Two weeks up to 4 weeks Discharge battery to storage voltage using 
charger.  
Note that multiple “timeouts” on the charger 
may occur in order to do this.  

More than 4 weeks After the battery is put into storage mode and 
attains storage voltage the battery must be 
charged up after 4 weeks then discharged to 
storage mode again. This acts as a gentle 
cycle for the battery. 



Never leave batteries out in the cold overnight or in direct sunlight for any period of time, this will 
shorten their useful life span and will permanently damage the batteries.  
 
Keep dust caps over plugs at all times and inspect inside the plugs regularly for dirt and erosion.  
 
Batteries must be disposed of in an environmentally friendly manner and transported in 
accordance with the transportation of dangerous goods as outlined by Transport Canada.  
 
The panel on each battery has 4 white rectangular LED’s beside a “Power  button” 
On the other side of the battery panel are three triangle LED’s. 
 

Stryder MK I Battery buttons / LED  

Power button / LED 
 
The button on the Stryder MK I batteries is simple in its function. It can not be put into forced 
balance mode or any other mode. The button is simply to check the charge status of the 
batteries and check if any over / under temperature conditions exist as per the following chart 
 
Note: 
White LED shows battery capacity, red LED shows battery abnormal alarm. 

 

 

Stryder MK III Battery buttons / LED  

Power button / LED 
The power LED is also a button used to turn the battery panel on and off.  
 
Currently there is no need to “turn on” the battery, however this is how the “on” and “off” 
functions.  
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Button LED LED1red LED2red LED3red LED4red Instruction 

on on on on flash Over-voltage alarm 
on flash on on on Under-voltage alarm 
on flash flash on on Under-temperature alarm 
on on on flash flash Over-temperature alarm 
on on on off off Low power damage alarm 
on on off off on Large cell Imbalance 



To turn the battery “on” or “off” the user is to perform a short push followed by a long push of the 
power button. After this you will see the white rectangle LED’s light up in sequence showing 
weather the battery has been turned on or off.  
 
If the battery is turned on the lights will “increase” as they light up moving away from the power 
button. If the battery is turned off then the lights will “decrease” as they start all light up and 
decrease one by one moving toward the power button.  
 
A short press of the power button will display the current charge of the battery as follows. 
 
 

 

Self balancing 
The battery will automatically balance itself during which time the Red triangle LED will light up. 
It is normal to see the red triangle light on and off while stored. This will be cleared when the 
battery is balance charged.  
 
There is no way to “force balance” the pack. This is done automatically.  
 
Self discharge to storage 
 
If the battery is put away at full charge it will wait 5 days and will start slowly discharging. This 
process may cause the battery to heat up slightly and this is normal operation.  
 
Battery lifespan meter 
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Remaining power LED1 LED2 LED3 LED4 

0-12% Blinking Off Off Off 

13-24% On Off Off Off 

25-37% On Blinking Off Off 

38-49% On On Off Off 

50-62% On On Blinking Off 

63-74% On On On Off 

95-94% On On On Blink 

95-100% On On On On 



Lipo batteries have a maximum lifespan cycle before they need to be replaced. These batteries 
have an internal meter that counts charge cycles as well as other factors in order to estimate 
battery lifespan.  
 
To check total battery life first ensure the power is “off” on the battery. Typically it is never turned 
“on” so by default it will likely be in the off mode.  
 
Press and hold the power button for 5 seconds. The LED will first show current charge status of 
the battery but when power button is held for more than 5 seconds they LED’s will display how 
much total battery life is left.  
 
See the following chart for levels 
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Lifespan LED1 LED2 LED3 LED4 

88-100% On On On On 

75-87% On On On Blinking 

63-74% On On On Off 

50-62% On On Blinking Off 

38-49% On On Off Off 

25-37% On Blinking Off Off 

13-24% On Off Off Off 

Below 12% Blinking Off Off Off 



Warnings and info 
 
The triangle shaped LED’s have the following indications. Generally the user will only see one 
Red triangle light up and this is relatively normal. It is assumed that the user charges the pack 
with the “balance” mode selected and the user must review all cell balances to ensure they are 
within 0.03V of each other.  
 

 

Maintenance (MK I and MK III airframes) 

General info 
The Stryder motors are professional quality motors with built in electronic speeds controls. This 
means quiet, smooth, efficient flight. The motors themselves should not get more than warm to 
the touch. If any one motor is hot to touch after flight STOP flying immediately and return the 
aircraft to your reseller for inspection and replacement. 
 
Stryder motors are a brushless design. However there are still bearings inside the motors. If any 
excessive noise is heard such as dragging, grinding, squealing while rotating the motors by 
hand or while powered then STOP flying and return the aircraft to your reseller for inspection 
and replacement. 
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Red LED Orange LED Whilte LED Description 

Blinking   Over temperature warning 2 
Damage may have occurred fly with caution 

On   Cell unbalanced warning 2 
Check balance on charger during next charge 

 On  Battery low  
Cell damage may have occurred 
Balance charge and review all cell levels 

  Blinking Over temperature warning 1 
Damage may have occurred fly with caution 

  On Cells unbalanced warning 1 
Check balance on charger during next charge 

On  On Battery warning error (other) 



Hour meter schedule 
 
The Stryder Drone should be sent in for scheduled review and maintenance every 50 hours of 
flight. Logging these flight hours is the responsibility of the drone owner. An hour meter is 
provided and must be monitored by the pilot to maintain airworthiness and compliance. 
 
Routine scheduled maintenance can only be done by an Epoc Unmanned Inc. qualified service 
technician.  If a maintenance schedule is not adhered to this will void all warranties on the 
product. 
 
The total lifespan of Stryder drones is 250 hours time. After this time it is required to replace the 
airframe and power train. 

Troubleshooting 

Aircraft flight 

Drone will not arm 
 
This may be due to the transmitter drifting out of calibration see “calibrating transmitter” section 
in this document. 
 
Sometimes GPS locations is not sufficient for the drone to arm. Click on EKF and if any of the 
text in this box is RED the drone is not arming because of some sort of GPS anomaly. Usually 
this is corrected by waiting for 15-20 minutes or changing launch locations.  

Drone drifting in Position hold 
 
This may be due to the transmitter drifting out of calibration see “calibrating transmitter” section 
in this document. 
 
If the transmitter trims are out of center this will also cause drift and abnormal flight behavior.  
 
Note that any movement of the transmitter sticks will cause movement of the drone so be 
careful not to be leaning on or moving the sticks while performing a hover test.  
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Drone takes off again after landing 
This can occur when the user does not maintain the disarm command long enough to 
completely disarm the motors after landing. Always ensure to hold the disarm command upon 
touchdown until the motors stop spinning. 

Drone is not taking photos in flight 
This is usually corrected by re-planning and uploading the mission in Mission Planner. If this 
does not resolve the issue then change the switch on the drone to the rear position. This will 
force the payload to take photos based on a 120 meter altitude. Note that the switch must be set 
before the payload is started and there is a 90m lockout for photos. Therefore the mission you 
have planned must take the drone to the standard 120m height or the distance trigger will not 
work. 
 

Drone seems to be taking off to an unknown location.  
 
This is an emergency and should be dealt with by selecting RTL on the transmitter and then on 
the GCS if the drone does not respect the transmitter signal. The only time this happens is when 
the user forgets to upload a new mission and the drone takes off to the first waypoint of the old 
mission.  

Drone circling in position hold 
This is due to compass interference and or physical rotation or damage to the compass. Stop 
flying immediately and contact Epoc.  

Drone yaw’s in flight or does not complete turn 
This is usually due to a poor quality signal from the transmitter. After doing a transmitter 
calibration the user should monitor the LIVE stick position in the calibration screen. While 
looking at the small circle does it “jump around” if so then the transmitter may need to be 
replaced. 

Drone’s artificial horizon is not level when drone is level 
This can occur with large temperature swings. Usually when the drone is left to sit level the AH 
will slowly return to horizontal position. Resetting level is possible but Epoc should be contacted 
prior to doing so.  
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Downloading logs 

Telemetry logs (off laptop) 
1) Browse to C:\users\toughbook\documents\Mission Planner\logs\QUADROTOR\1 
2) This is where the telemetry logs are stored for each flight.  

3) List the files by name and review the dates on the files. Take all files with the date for 
review and copy them to a new folder on your desktop. 

 
4) Zip up all files copied and send them in dropbox or similar. They can be rather large so it 

may be required to do one flight at a time.  

Aircraft logs (off aircraft) 
NOTE: The drone does not need to be powered with the battery in order to download the 
logs. 

This will clean up the logs so that they are easier to manage: 

1) Browse to C:\users\toughbook\documents\Mission Planner\logs\QUADROTOR\1 
2) This directory may already have files inside it. 
3) Inside the “1” directory create a new folder called “obsolete” or “old”  
4) Move everything in the “1” directory to the “obsolete” directory.  
5) Now there should be nothing left in this directory 

C:\Users\Burgs\Documents\MissionPlanner\logs\QUADROTOR\1 (except a folder called 
“obsolete”) 

Downloading logs 

1) Start Mission Planner 
2) Plug in a usb cable to the drone usb port 
3) Plug in the other end to the PC 
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4) Allow any drivers to be installed (wait 20-30 seconds the first time it is plugged in) 
5) In Mission Planner select the drop down menu and you will see a new comport number. 

Select this com port 
6) Change the Baud rate to 115200 
7) Click “Connect” 
8) After the drone has attained all the parameters click on the data flash logs tab under the 

HUD 
9) Click “download data flash log via mavlink” 
10) Scroll to the bottom to see the most recent logs.  
11) Check off the logs you want to download. 
12) Click download selected logs. If you select all logs or many logs it will take a very long 

time to attain them.  
13) Wait for the download to complete. The computer will beep when done. 
14) Logs are located as per the above directory and for each flight you will see the following 

files generated the most important is the .bin file

 

15) Zip up all files generated and send them in dropbox or similar. They can be rather large 
so it may be required to do one flight at a time.  

Performance and system specifications (MK I and MK III) 

General 
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Description Stryder MK I Stryder MK III 

Wingspan 880 mm / 35” 1300 mm / 51” 

Rotor Diameter (4 Rotors) 457 mm / 18” 762 mm / 30” 

Maximum take-off weight 7 kg / 15 lb 25 kg / 55 lb 

Maximum Payload (not 
including batteries) 

6.4 kg / 14 lb 10 kg / 22 lb 



Propulsion 
 

Performance 
 

 

Takeoff and landing 
 

 

Electrical 
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Empty Weight (not including 
batteries) 

4.4 kg / 9.7 lb 7 kg / 15lb 

Description Stryder MK I Stryder MK III 

Electric motor (4 motors) 380KV 100KV 

Propellers 18” propellers carbon plastic 
composite 

30” propellers carbon plastic 
composite 

Description Stryder MK I Stryder MK III 

Maximum operating speed 10 m/sec 10 m/sec 

Maximum ascent rate 5 m/sec 9.7 kn 5 m/sec 9.7 kn 

Maximum descent rate 3 m/sec 5.8 kn 3 m/sec 5.8 kn 

Maximum altitude 120 m / 400 ‘ AGL 
(electronically limited) 

120 m / 400 ‘ AGL 
(electronically limited) 

Maximum endurance 28 minutes with direct geo 
payload 

30 minutes with direct geo 
payload 

Description Stryder MK I Stryder MK III 

Takeoff method Vertical takeoff Vertical takeoff 

Landing method Vertical landing Vertical landing 

Landing accuracy ~3m ~3m 



 

Environmental 
 

 
The normal operating temperature range of the Stryder drone is -30 to +30 deg C. If operating 
outside of these limits please contact the distributor or Epoc Unmanned Inc. directly to ensure 
safe operating procedures are followed.  
 
If it is required to operate outside the above operating conditions special approval from Epoc 
Unmanned must be obtained otherwise warranty and compliance are void. 
 

Firmware 
Stryder firmware for all hardware is not to be modified by the user. Any modification or 
adjustment of parameters in any way will void all warranties.  
 
Epoc Unmanned maintains constant review of all firmware releases. If a firmware update is 
required for safety reasons Epoc will contact the customer and arrange to update the firmware. 
If the customer refuses to update the firmware the drone is flown at the customers risk.  
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Description Stryder MK I Stryder MK III 

Battery type 22.5v 22,000 mAh Lithium 
Polymer battery 

44v 32,000 mAh Lithium 
Polymer battery 

Main battery fully charged 25.2V 50.4V 

Main battery low voltage 21.6V 44.0V 

Main battery charge limit 25.2V 50.4V 

Main battery discharge limit 21.2V 39.6V 

Transmitter freq. 900mhz 900mhz 

Telemetry freq. 900mhz 900mhz 

Description Stryder MK I Stryder MK III 

Wind resistance 10 m/sec 14 m/sec 

Temperature operating range -30ºC to +30 ºC -30ºC to +30 ºC 



Glossary 
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RTL Return to Launch 

  

  

  


